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Introduction 

You should read through this revision guide when you feel that you are ready for assessment on 

Unit E. It will help to refresh your memory and consolidate your learning. It does not reproduce 

all the learning of the course, but summarises the key points. If you need a further reminder, it 

tells you which sections of the course materials you should revisit. 

How to use this guide 

This revision guide contains the following sections: 

� Working with files - tells you how to manage files and folders on the computer 

� Choosing applications – explains how to select an appropriate application for the task you 
have to carry out 

� Using software effectively – tells you how to use the tools offered by applications to help 
you work effectively 

� Working with more than one application – explains how data from more than one 
application can be combined in integrated documents 

� Computers and the law – outlines how the law regarding copyright, privacy and computer 
use affects you  

� Keeping data safe – explains how to protect your data against loss through viruses, 
sabotage and accidents 
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� Health, safety and the environment – tells you how to safeguard your health and protect 
the environment by using computers safely and thoughtfully. 

Each part of the revision guide has: 

� an introduction that outlines the topics covered in the section 

� a list of key terms you should be familiar with – if there are any that you don’t feel you 
know well, work through the rest of the section carefully  

� one or more knowledge top-up topics to help you recall the material you have learned and 
fill any gaps in your skills and knowledge 

� check your knowledge questions to help you to make sure that you have understood and 
remembered the learning covered in the section 

� a ‘remind yourself’ section which directs you to the appropriate parts of the course 
materials if you would like to work through any topics again to complete your learning. 

New words are explained the first time they occur. If you come across a word you don’t know, 
and it isn’t explained, look in the glossary to find its meaning. 
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Working with files 

All your work on the computer is stored in files, or documents. You can organise these into 

folders to make them easier to manage. To work effectively with the computer, you need to 

be able to move, copy, delete and create folders and files, and to recognise different types of 

files and the applications that can work with them. 

Key terms 

If your work on files is complete, you should be certain that you know what these terms mean: 

� file, folder 

� file type, file extension 

� application, Windows explorer. 

Knowledge top-up: Looking at files and folders 

On any computer with a graphical user interface, files, folders, disks and other resources are 
all represented by icons, or little pictures.  

To see the files and folders on one of your disks, you can either: 

� open the My Computer window and double-click on the icon for the disk, or 

� use Windows Explorer.   



Working with files 

To start Windows Explorer, either  

� click on the Start button, display the Programs menu and choose Windows Explorer from 

the Accessories sub-menu, or  

� right-click on the Start button and choose Explore.  

 

To open any folders on the disk, double-click on the folder icon in the filer window or on the 
‘+’ sign beside the folder in the Explorer window. 

Recognising files 

Files have different types, or formats, according to what they contain and the applications 
which use them. The icon used tells you the type of file it is or which application (computer 
program) can use it.  

©  learndirect  8 



Working with files 

 

You can also tell the file type from the file extension – three letters that can be displayed at 
the end of the file name (eg filename.DOC). You will probably come across these file types:  

� .DOC – a Word document 

� .RTF – a type of text document that can be opened by different types of word processor, 

keeping some of its styling 

� .TXT – a plain text document with no styling and formatting information 

� .XLS – an Excel spreadsheet 
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� .MDB – an Access database 

� .PPS – a PowerPoint presentation 

� .GIF, .JPG, .BMP – image files (picture) 

� .HTM – a web page 

� .AVI, .MOV, .MPG – movie files 

� .WAV, .MP3 – sound (or music) files 

� .ZIP – a compressed (or zipped) file 

� .EXE – an executable file (application or program) 

� .TMP – a temporary Windows file created by the computer for its own use. 

Knowledge top-up: Opening a file 

There are several ways to open a file in an application. You can 

� double-click on its icon in the filer or Explorer window 

� open an application that can use the file, choose Open from the File menu, locate the the 

file and click on Open 

� right-click on its icon on the desktop and choose Open from the File menu 

� click on the Start button, then on Run, browse for the file and click OK. 
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Knowledge top-up: Using folders 

To create a folder to hold your files, you need to display the location where you want to put 
the folder using the desktop or Windows Explorer, then choose New and then Folder from the 
File menu. 

Once you have a new folder, you can give it a name and move or copy files and other folders 
into it.  

Knowledge top-up: Moving, copying, renaming and deleting files 

There are several ways to carry out common operations on files and folders.  

To move a file or folder, you can: 

� click on its icon to select it and then drag it to where you want it to be, or  

� click on it and choose Cut, then open the destination folder and choose Paste. You can 

choose Cut and Paste either from the Edit menu in the window, or from the menu 

displayed when you right-click on the icon, or 

� click on it and choose Move To Folder, then indicate where you want to put it. You can 

choose Move to Folder either from the Edit menu in the window, or from the menu 

displayed when you right-click on the icon 

Note: if you drag a file or folder to a different disk, it is copied, not moved. 

To copy a file or folder, you can 

� click on its icon, hold down the Control key and drag it to where you want the copy, or 
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� click on it and choose Copy, then open the destination folder and choose Paste. You can 

choose Copy and Paste either from the Edit menu in the window, or from the menu 

displayed when you right-click on the icon, or 

� click on it and choose Copy To Folder, then indicate where you want to put the copy. You 

can choose Copy to Folder either from the Edit menu in the window, or from the menu 

displayed when you right-click on the icon 

To delete a file or folder,  

� drag its icon to the Recycle bin on the desktop, or 

� click on it and choose Delete from the menu. You can choose Delete either from the Edit 

menu in the window, or from the menu displayed when you right-click on the icon.  

Beware – if you delete a folder, all its contents will be deleted, too. 

To rename a file or folder, click on its icon and choose Rename from the menu. You can 
choose Rename either from the Edit menu or from the menu displayed when you right-click on 
the icon. 

Restoring files and folders 

If you accidentally delete something, or delete a file or folder and then realise that you still 
want it, you may be able to restore it without having to retrieve it from your back-up copy.  

Anything that you delete from the hard disk may be stored in the recycle bin on the computer. 
If you have not emptied the recycle bin, you can restore the file from the bin. Not everything is  
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stored in the recycle bin, though. If you delete something from within an application, or save 
something else with the same name, you won’t be able to restore it from the recycle bin. 

If you delete something from a floppy disk, you can’t restore it. 

Check your knowledge 

1. Which file type tells you a file is a web page? 

� .DOC 

� .HTM 

� .JPG 

� .AVI 

2. Which method will NOT delete a file? 

� Click on its icon in the Explorer window and choose Cut from the Edit menu 

� Drag its icon to the Recycle bin 

� Right-click on its icon and choose Delete 

3. If you wanted to divide the files in a folder labelled ‘Final reports’ between two new 
folders, called ‘Reportsa’ and ‘Reportsb’, which sequence of events would you use? 

� Delete the existing folder, create two new folders and give them the names ‘Reportsa’
and ‘Reportsb’, then copy the files into them 

� Create two new folders and give them the names ‘Reportsa’ and ‘Reportsb’, then 
move the files into them and finally delete the old folder 
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� Select the files in the old folder and choose Move To Folder, then delete the old folder, 
create two new folders and use Paste to put the files into them 

� Rename the old folder ‘Reportsa’ and delete half the files in it. 

Remind yourself 

If you want to do more work on working with files, use the course Using your computer. To 
find out more about: 

� file types - work through the section Working with Windows Explorer  – Recognising file 

types 

� opening a file - work through the section Working with Windows Explorer  – Launching 

WordPad 

� using folders – work through the section Working with Windows Explorer  – Organising 

your files and folders 

� moving, copying, renaming and deleting files – work through the section Working with 

Windows Explorer  – Organising your files and folders. 
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Check your answers 

1. Web pages have the file extension .HTM. 

2. The file will not be deleted if you click on its icon in the Explorer window and choose Cut 
from the Edit menu. You can use this method, with Paste, to move a file. 

3. You would need to create two new folders and give them the names ‘Reportsa’ and ‘Reportsb’,
then move the files into them and finally delete the old folder. 
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Choosing applications 

There are many different types of software application. It is important to choose the most 

appropriate type for the task you want to accomplish. Some of the most common types of 

application are: 

� word processor 

� spreadsheet application 

� database application 

� presentations application. 

Key terms 

If your work on choosing applications is complete, you should be certain that you know what 
these terms mean: 

� word processor, text editor, desktop publishing, presentation, slide show 

� spreadsheet, cell, formula 

� database, record, table, query, form, report, search, sort. 

Knowledge top-up: Working with text 

There are different ways in which you may want to work with text. Often, you need to think 
about how you will use your finished document to help you decide which application to use.  



Choosing applications 

word processorA  is the best choice if you want to use different sizes and styles of text in your 
document, and perhaps include pictures and tables. A word processor makes it easy to make 
changes and revisions to a document, and has many features to help you process your text 
effectively as well as to present it attractively. 

 

desktop publishingA  application is a good choice if you need to make a printed document with 
a very complicated or sophisticated arrangement of text and pictures. 

presentationsA  application is the best choice if you want to produce slides that you can use to 
give a presentation or slideshow, either using the computer or as printed overhead projector 
(OHP) transparencies. Again, you can use different styles of text and include charts and 
pictures. You can even include sound or video files if you are going to deliver the presentation 
on a computer. 
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text editorA  is suitable only if you want to produce very plain text with no special features. It 
has the advantage that the file can be used in or imported (copied) into lots of different types 
of application. 

Knowledge top-up: Working with facts and figures 

When you need to work with facts and figures, you will probably use a spreadsheet or database 
application. 

spreadsheetA  is best when you need to carry out a lot of calculations, or try different figures 
to model different situations and predict results. A spreadsheet application can draw graphs 
and charts from your figures, too. It can work with ordinary numbers, but also with dates, 
currency and other types of number. It is often used for financial work, such as working out 
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budgets and planning spending. A spreadsheet is a grid of cells, each of which can hold a value 
or a formula. A formula works out a value by carrying out calculations on the values in other 
cells. 

 

databaseA  is best when you need to store lots of information, especially if much of it is in text 
form. Databases can also handle numbers, and can carry out some calculations on the numbers 
stored, but their main strength is in sorting and searching information. Information is put into 
the database using forms records tables and stored as  in . The database is investigated using 
queries, which sort and search the information. Results of sorting and searching are shown in 
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reports and, sometimes, charts or graphs. A database is often used to keep track of contact 
details, items in catalogues, students’ course details, exam results, and so on. 

 

Knowledge top-up: Working with pictures 

If you want to create pictures, or work on pictures you have scanned into the computer or 
taken with a digital camera, you will need to use a special graphics application (sometimes 
called an image editor). There are many different types, suitable for working with different 
types of pictures.  

Often, pictures are used with text. You might need to use: 
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� a desktop publishing application to produce a document that mixes text and pictures in a 

complicated layout, like a magazine 

� a presentations application to produce a slideshow or multimedia sequence to present on 

the computer or using an OHP and transparencies. You can also use it to produce a 

multimedia display, perhaps to run in a kiosk at a museum or exhibition. 

Check your knowledge 

1. Which application would you use if you wanted to create a catalogue of CDs kept in a 
music library? 

� spreadsheet application 

� word processor 

� presentations application 

� database 

2. Which application would you use if you wanted to create a multimedia sequence to run on 
a computer in an art gallery? 

� spreadsheet application 

� word processor 

� presentations application 

� database 
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3. Which application would you use if you wanted to find out how pricing might affect sales 
of a new product? 

� spreadsheet application 

� word processor 

� presentations application 

� database. 

Remind yourself 

If you want to do more work on choosing suitable software, use the course Using your 
computer and work through the section A typical computer system – Introducing applications.

 

Check your answers 

1. You would need to use a database as you are dealing with a large collection of information 
that you want to sort and search. 

2. You would need to use a presentations application. 

3. You would need to use a spreadsheet as it can carry out lots of calculations very quickly. 
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Using software effectively

Once you have chosen suitable software for a task, you need to use the software effectively to 

make the most of it and accomplish the task in the best possible way. If you don’t know about 

all the features available in the software that you have chosen, your task will be more difficult 

and your results may be less than perfect. 

Key terms 

If your work on using applications is complete, you should be certain that you know what these 
terms mean: 

� cell, record, field 

� integer, decimal, currency format, autonumber, formula 

� wildcard 

� line chart, bar chart, pie chart, scatter chart 

� style, header, footer. 

Knowledge top-up: Storing information 

When you use a database or spreadsheet to store information, it is kept in a field or cell. There 
are many types of information you can store. 
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Formats for cells and fields 

The format that you choose for the field or cell controls how the information will be displayed 
and handled. For example, you could store information as 

� a piece of text - even if numbers are included, they are treated as though they were 

letters and can’t be used for calculations 

integer (whole number) – can be used for calculations � an 

decimal� a  number (you can set how many decimal places are shown) – can be used for 

calculations 

currency - two decimal places are shown, for pence or cents, and a pound, dollar or euro 

sign appears at the start – use it for costs and prices; can be used for calculations 

� 

 

� a date - there are several ways to show dates and you may choose which to use (for 

example, ‘short date’ shows the date like this: 28/05/2005, or ‘long date’ shows it like 

this: Saturday, 28 May 2005 )  

� a yes/no question – may be shown as a tick box or a letter (Y/N or T/F, for true/false) 
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� autonumber – a number allocated by the application: it numbers each entry in order. 

There are other options, too.  

It’s important to choose an appropriate format as it affects how the data will be displayed and 
processed. The right format is not always the most obvious. For example, if you wanted to 
store telephone numbers, you should keep them as text. If you kept them as numbers, these 
problems could occur: 

� they may be shown as decimals, with zeroes added to the end 

� the starting zero would be dropped 

� no space would be shown after the area code  

� you could not use ‘+’ to show an international number format. 

So if you entered the number 01212 121212, it could appear as  

1212121212.00 

If you store numbers as text when you don’t need to, different problems arise. Most 
importantly, you can’t carry out calculations using the numbers. But if you put the numbers 1-
100 in order, they wouldn’t appear in numeric order, like this: 

1, 2, 3, 4, 5… 10, 11, 12… 20…100 

Instead, all the numbers with a ‘1’ at the start would come first, then all those with a  ‘2’ at 
the start and so on, like this:  

1, 10, 100, 11, 12, 13…2, 20, 21…99 
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Values and formulae 

In a spreadsheet, a cell can hold a value, such as a number or text, or it can hold a formula. A 
formula describes an operation or calculation, using other numbers and the contents of other 
cells. For example, the formula  

=C1*2 

means ‘show the content of cell C1, multiplied by 2’. The formula 

=B2+B3+B4 

means ‘show the result of adding the values in cells B2, B3 and B4’. 

 

To use spreadsheets effectively, you should refer to the values in cells rather than type in the 
same values repeatedly. So if you wanted to multiply all prices by the same tax rate, you 
should put the tax rate into a cell and refer to that in the formulae (for example ‘=B2*A3’ 
rather than ‘=B2*0.175’). This means that if the tax rate changes, you only need to change one 
cell and the whole spreadsheet will update automatically. 
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Knowledge top-up: Editing information 

Software applications have lots of tools to make it easy to edit (make changes to) your 
information. Even if information has been entered correctly, errors sometimes creep in when 
you edit it. Make any changes carefully and check your work afterwards. Here are some 
examples of possible problems to look out for. 

Copying cells in a spreadsheet 

When you copy, or replicate, cells in a spreadsheet, check that the result matches the original 
cells you copied. Make sure the cell formats are the same after copying, for instance, and that 
any blank cells remain blank, rather than having a zero value. This last point is important for 
several reasons: 

� if a cell shows zero, it looks as though it should hold a value and people using the 

spreadsheet later may be confused or make mistakes as a result 

� if the cell is part of a range included in any calculations, the zero may affect the 

calculation (if it is used in averaging, for instance) 

� blank cells are often used to separate blocks of cells, and they won’t be effective if it 

looks as though they hold values. 

Make sure that any cells referring to other cells refer to the right ones in the copied block. You 
might need to change some references if cells referred to are outside the copied block. 

Finding and replacing text 

Many applications offer a Find/Replace option to help you change all or many instances of the 
same text in a document. For example, if you had typed a long report in which you referred to 



Using software effectively 

©  learndirect  28 

the director of a project as ‘Dr Biggs’, but the director has asked you to change her name to 
Samantha Biggs, you could do this easily using Find (or Search) and Replace to change all 
instances of ‘Dr Biggs’ to ‘Samantha Biggs’. Be careful when you use this tool that you only 
change the examples you want to change. It would be risky to change just ‘Dr’ to ‘Samantha’ 
as other instances of ‘dr’ could also change, including ‘Dr Harris’ and even ‘dreadful’! 

Knowledge top-up: Processing information 

There are many tools to help you work with data, rearranging it and finding out new 
information by carrying out calculations, searches and comparisons. Look for the best tools for 
each task, and use each tool carefully to avoid making mistakes. Again, here are some issues to 
look out for. 

Sorting information 

If you are using a database or spreadsheet and want to sort some of the information, make sure 
that you include all the information relating to each record or row that you want to sort. For 
instance, if you had a list of names and dates of birth which you wanted to put in alphabetical 
order, you shouldn’t select only the names and then choose Sort. The result would be to put 
the names in alphabetical order, but leave the dates of birth in the original order. Each name 
would no longer be alongside the right date of birth - you would have jumbled up the 
information. 

Searching information 

You will often need to carry out searches on information held in a database in order to find the 
details that you need. You can search using a single search term – finding all customers with 
the name Jenkins, for example. Or you can search on two or more search terms. When you use 
two or more, you can specify the relationship between them. So you might search for all 
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customers called Jenkins OR Jones, or for customers called Jones who live in Southsea. To do 
the second of these, you would need to search on the Name field for Jones AND the Town field 
for Southsea. The words used to set the relationship between the terms are:  

� AND (both must be present – eg Jones AND Andrew to find ‘Andrew Jones’ 

� OR (one must be present – eg Jones OR Jenkins to find people named Jones or named 

Jenkins) 

� NOT (one must be present, and the other not present – Jones NOT Andrew to find people 

called Jones whose first name is not Andrew). 

You can use the same methods to search the world wide web using a search page (also called a 
search engine).  

Using wildcards 

You may be able to use a wildcard to help you find the information you are looking for in a 
search. A wildcard is a character that stands for something else. The most common wildcards 
are: 

* stands for any string (group of characters) 

? stands for a single character 

So b?d would find bad, bed, bid, and b3d; b*d would find all these, but also bread, borrowed, 
bubbled, b2514zxqd and anything else that starts with b and ends with d. It would also find 
bd as it will match an empty string (zero characters). 
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You can often use wildcards when searching a database or spreadsheet, and sometimes when 
using Find and Replace. For example, to find all people whose surnames end in S, you would 
search on the surname field for *S. 

Knowledge top-up: Presenting information 

To make information meaningful and accessible to other people, it is important to present it 
effectively. All software applications have tools to help you improve the presentation of your 
work.  

Effective text 

Use headings and emphasis to draw attention to the structure of your text and to important 
passages. To make portions of text stand out, you can use 

� bold text 

� italic text 

� underlined text. 

Give a long document a sensible structure, breaking it into sections and subsections. To make 
the structure clear, use the same style and size of text for all headings that have the same 
status. To make it easy to do this, use the word processor’s styles feature. This lets you set up 
a named style that can be used for all headings of the same type. The style sets features such 
as text size, colour and font. Use the appropriate heading style for each heading of that type.  

To help people find their way around a document, it’s a good idea to include page numbers and 
sometimes section names on each page. The best way to do this is to use a header or footer – 
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information that is printed at the top or bottom of every page. In the header or footer, you can 
use a page number tool which will automatically put the right page number on each page.  

Effective graphs and charts 

It is often easier to understand information if it is shown in a graph or chart, rather than a 
table or list of numbers. It’s important to choose an appropriate type of chart to make the 
information clear to people who need to use it. 

line chartA  is appropriate if there is a continuous stream of values, and you may want to read 
off values in between the data points used to draw the chart. For example, you might record 
the temperature in a room over a day and draw a line chart. If the temperature had not been 
measured at 2.30 pm, people could still get a good idea of what the temperature would have 
been then by looking at the chart, as the line will go through 2.30. 
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pie chart A is appropriate if you are showing how a group is divided into a small number of sets 
– such as how many people vote for each political party. If there are too many groups, a pie 
chart becomes difficult to use. 

 

bar chartA  is best when there is not a continuous stream of values, but discrete figures. For 
example, if you wanted to show how many pupils attended school on each weekday – there is a 
fixed number for each day, and no days in between for which you might need to infer values. A 
bar chart is also best if you want to compare two or more sets of values. 
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scatter chartA  is best when a lot of data has been collected and the figures are used to show a 
trend. A line drawn between all the plotted values shows the general trend. For example, a 
scatter chart would be useful if you wanted to plot how many plants germinated in each of ten 
pots, with the experiment repeated at each of ten temperatures. 
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Check your knowledge 

Make sure you’ve understood and remembered the learning in this section by answering these 
quick questions. The answers are at the end of this section. 

1. Which expression with a wildcard would you use to find all customers whose customer ID 
numbers contain a 3? 

� *3 

� 3* 

� ***3*** 

� *3* 

2. How would you add the page number to each page of the draft of a long report? 

� Type the page number in the last line of text on each page 

� Add a header or footer and use the Page number tool 

� Use the Styles feature in the word processor 

� It’s not a good idea to add the page numbers because they will change if you edit the 
report 

3. If you wanted to look on the Internet for a campsite near the beach, which is not in 
Norfolk, which search terms would use? 

� campsite AND beach AND Norfolk 

� campsite OR beach AND Norfolk 
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� campsite AND beach NOT Norfolk 

� campsite OR beach NOT Norfolk 

4. Which type of chart would you use to show the proportions of cows, chickens and goats 
chosen by people paying an aid charity to send farm animals to a village in Africa? 

� line chart 

� bar chart 

� pie chart.  

Remind yourself 

If you want to do more work on  

� storing information – work through Spreadsheets: Entering and formatting data - 

Formatting numbers; Spreadsheets: Basic formulas and functions and Databases: Setting 

up a database - Applying data types to fields 

� editing information – work through Spreadsheets: Editing and organising data; Databases: 

Working with tables – Editing an existing database; Databases: Working with tables – 

Modifying a table and Word processing: Entering and editing text – Finding and replacing 

text 

� processing information – work through Databases: Sorting records in a database and 

Databases: Working with queries  
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� presenting information – work through Spreadsheets: Charts; Word processing: 

Structuring your documents – Headers and footers; Word processing: Structuring your 

documents – Inserting page numbers and dates; Word processing: Changing the look of 

documents – Working with styles and Word processing: Changing the look of documents – 

Formatting text. 

 

Check your answers 

1. To find all customers whose customer ID numbers contain a 3 you would need to use *3* as 
that will find a 3 even if there are characters before and after it. The sequence ***3*** 
would also work, but the extra * characters are unnecessary. 

2. You would need to add a header or footer and use the Page number tool. 

3. You would need to search for campsite AND beach NOT Norfolk. 

4. A pie chart would be the best way of showing the proportions of people who chose each 
type of animal. 
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Working with more than one application  

In other parts of your work for ECDL you have learned how to use different types of software 

application – such as spreadsheets, databases and word processing applications. You can also 

use these together to create integrated documents, or you can move data between 

applications using suitable file formats. 

Key terms 

If your work on using multiple applications is complete, you should be certain that you know 
what these terms mean: 

� clipboard 

� import, embed, link 

� file format 

� mail merge, data source. 

Knowledge top-up: Moving information between applications 

It’s often useful to move information between different software applications. You can move 
information between applications of the same type – two different word processing 
applications, for example – or between different types of application. For instance, you might 
want to use a picture or a chart in a text document.  

You can move information by 
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� saving files in formats that can be used by other applications 

� copying and pasting information between files in different applications 

� importing a file from one application into a file in another application 

� linking a file of one type to a file of a different type. 

Knowledge top-up: Choosing file formats 

If you know that you will want to open a file in a different application or include it in a file of 
another type, you need to save it using a suitable file format. Some file formats are 
understood by several or many applications; others are only recognised by the application used 
to create the file.  

File formats for sharing information 

There are several file formats that are particularly useful for moving data between different 
applications. Much or all of the formatting and styling of the document will be lost when you 
choose some of these formats – but at least most of the information can be transferred more 
quickly than retyping it. Consider these file formats: 

� CSV files for moving spreadsheet data between spreadsheets or spreadsheets and 
databases 

� RTF files for moving text documents between word processing applications, keeping much 
of the styling 

� TXT (text) files for moving text documents between different types of application, but 
losing all of the styling 
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� BMP, GIF or JPEG files for moving pictures between different types of application. The 
number of colours is reduced in a GIF file, and transparent areas will become solid colours 
in a BMP or JPEG file. 

It is often useful to save information in one of these formats if you are sending it to someone 
else and don’t know which application they will use to look at or edit it.  

If you know someone will use a word processor to look at your text, but don’t know which one 
they will use, you should send it as an RTF (.rtf) file so that much of the styling and formatting 
are kept.  

Working with Microsoft Office 

If you are using Microsoft Office applications, they can all accept files created in the other 
Office applications, so you can put an Excel chart in a Word document or PowerPoint 
presentation, for example. 

Knowledge top-up: Embedding information 

If you work with compatible types of file, you can copy and paste information between 
applications, or import a file created with one application into a file created with a different 
application.  

When you copy and paste information you generally work with a portion of a file – perhaps a 
few paragraphs of text, a single chart or part of a spreadsheet. 

When you import information, you add a complete file into the host document. 

Information that is copied or imported into another file is often called embed a file data. It 
keeps no link with the file it was originally copied or imported from, but becomes part of the 
new file instead.  
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Copy and Paste 

To copy information between two applications you need to: 

� open both applications, and the files you want to use in each 

� select the information you want and use the Copy option to make a copy of it on the 
clipboard 

� switch to the other application, put the caret where you want the information to appear, 
and use the Paste option. 

 

Be careful when copying, and check your work afterwards to make sure you have copied the 
right information and put it in the right place. 

You can use Copy and Paste to move lots of types of information. For example you can: 
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� copy a chart or table into a text document or presentation 

� copy a picture into a presentation or text document 

� copy a table from a database into a text document or presentation. 

If you copy information like this, the new copy is completely separate from the original. If you 
make changes to the original document, the embedded copy is not updated. Often, it is better 
to link the information rather than copy it. 

Importing an object 

You can import a complete spreadsheet, document, chart or picture into a Word or Excel file 
using the Insert Object or Insert File option. Like copying with the clipboard, the new 
information is embedded and any changes you make later to the original file won’t appear in 
the Word document or Excel spreadsheet you have added it to. Importing a file makes a copy – 
the original will still be in place. 

Making changes 

You can often change some aspects of the style and size of an imported or copied object. For 
example, if you copied a picture or chart into a document or presentation, you could change its 
size by selecting it and dragging the resize handles. Remember to use a corner handle to keep 
the picture or chart in proportion.  
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There is usually a box you can tick to lock the aspect ratio when changing the size of a picture 
or chart. When this lock is on, the picture cannot be distorted because the same scale will be 
used to resize the horizontal and vertical dimensions. 

Preparing to copy or import information 

It’s important to make sure information is finished, complete and saved before you import it or 
copy it into another document. Remember that any changes you make later in the original file 
won’t show in the document you have imported it into. Make sure you check that: 

� any facts and figures are accurate 

� text has been correctly typed and styled 

� the colours, brightness, contrast and content of any pictures are as you want them. 

You will need to save the file in a format that the application you are using for the host 
document can recognise. For instance, if you are making a picture, you might need to save it as 
a .GIF, .BMP or .JPG (jpeg) file.  
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Knowledge top-up: Sharing and linking information 

When information is copied and embedded, there is no link with the original file. If the original 
changes, the embedded copy becomes out of date. To prevent this, you can make a link to the 
original file instead.  

If you are using Word, you can create a link to another file, such as a spreadsheet, or a table in 
a database, or even a picture. You need to copy the object and then use the Paste Special 
option in Word, choosing Link.  

If you link one document to another, any changes you make to the original file are updated in 
the linked copy. Even though this happens automatically, you should check each time you use a 
document with embedded information that it is showing the up-to-date version of the 
information. It won’t be able to update it if you move or rename the document. 

Remember that if you make changes to a linked object, your changes will be lost when the 
document next updates it from the source file. 

Knowledge top-up: Mail merge 

Mail merge uses linked files to create a batch of personalised letters or other documents. Each 
has the same main body of text, but is individually addressed and can include personal details.  

Mail merge combines information from different files, often created in different applications. 
Usually, the main document is created using a word processing application. A data source, 
which holds the information that varies from one copy to another (such as names and 
addresses), is usually created in a spreadsheet or database application, but it can be another 
word-processed document. The mail merge process takes personal details from the data source 
and puts them into the appropriate places in the main document, creating a series of 
personalised copies of the document. 
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Check your knowledge 

Make sure you’ve understood and remembered the learning in this section by answering these 
quick questions. The answers are at the end of this section. 

1. Which of these file formats would you use to move a document between two different 
word processing applications? 

� RTF 

� HTML 
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� CSV 

� TXT 

2. Which application could you NOT use to create the data source for a mail merge? 

� word processor 

� email application 

� spreadsheet application 

� database application  

3. Which statement about linked and embedded files is true? 

� If you change the spreadsheet source file, an embedded chart in a text document will 
update 

� If you change the spreadsheet source file, a linked chart in a text document will update 

� You can’t link a spreadsheet chart in a text document 

� You can’t embed a spreadsheet chart in a text document 

4. Which statement about copying information between applications is TRUE? 

� When you use the Copy option, a link is created to the selected text, chart or figures 

� When you use the Copy option, the selected information is copied into another document 

� When you use the Copy option, the selected information is copied onto the clipboard. 
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Remind yourself 

If you want to do more work on: 

� file formats – work through Using your computer: Working with Windows Explorer – 
Recognising file types 

� copying information between applications - work through Word processing: Working with 
graphics and data objects; Spreadsheets: Importing objects into a workbook; Databases: 
Introduction to printing – Saving data for use in other applications and Databases: 
Introduction to printing – Importing data from other applications 

� sharing and linking information in different files - work through Word processing: Working 
with graphics and data objects – Copying data from other applications, Modifying graphics 
and Changing the look of an imported chart; Spreadsheets: Importing objects into a 
workbook – Sharing objects between applications  

� using mail merge – work through Word processing: Publishing your work - Introduction to 
mail merge and Using mail merge 

 

Check your answers 

1. You would use an RTF file to move a document between word processors; if you used a 
TXT file, all the styling and formatting would be lost. 

2. You can’t use an email application to create the source file for a mail merge. 
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3. If you change the spreadsheet source file, a linked chart in a text document will update. 

4. When you use the Copy option, the selected information is copied onto the clipboard. 
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Computers and the law 

Computers are used to hold a lot of sensitive commercial and personal information. The law 

protects people and businesses against information being misused. It is important to 

understand how you must treat and deal with personal information and what you are allowed 

to do with software to be sure you act within the law. 

Key terms 

If your work on computers and the law is complete, you should be certain that you know what 
these terms mean: 

� data protection, computer misuse  

� hacking 

� copyright. 

Knowledge top-up: Working with sensitive data 

Businesses and government departments are keeping more and more details about people on 
computers. To protect people from misuse of this information, most countries have data 
protection laws. These set out how personal data can be collected, stored and used. In the UK, 
data protection is overseen by the Information Commissioner’s Office.  
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Understanding the law 

Data protection is controlled by the European Data Protection Act (1998) and the Freedom of 
Information Act (2000). 

Data Protection ActThe  covers the types of personal information individuals and organisations 
may hold about people, how they may gather that information what they may do with it, and 
how they must keep it. 

Freedom of Information ActThe  covers people’s right to see information held about them, 
and what they can do about information held about them, including their right to have errors 
corrected. 

Working within the law  

Organisations that hold personal data, and employees who work with it, are legally bound to 
look after it properly and use it correctly. It is a criminal offence to share personal details with 
anyone outside the organisation, or anyone who is not authorised to see it, or to use them for a 
purpose other than the purpose for which they were collected.  
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When collecting and storing data, an organisation must: 

� register to keep personal details 

� ask permission to keep a person’s details 

� only collect the information needed for the stated purpose 

� keep the data safe and secure 

� make sure the information kept is accurate and up to date 

� process it fairly and lawfully 

� delete information that is no longer needed. 

If you work with personal data, you must observe the law and the organisation’s policy. For 
instance, if you had to process the credit rating of a friend of yours, you could not let your 
feelings about them affect how you processed their details – you must treat it fairly and 
lawfully. Although people have a right to see information held about them, you should not 
reveal information immediately to anyone who asks about their personal details. Instead, you 
should tell them of their rights and refer them to the person in the organisation who is in 
charge of the information. 

Exemption 

A few organisations are exempt from some or all of the Data Protection Act. The police force, 
for example, does not have to reveal the details held about a suspect or a crime victim. The 
same is true of organisations working for national security. As complying with the regulations 
would affect crime prevention or security, they are exempt. 
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Knowledge top-up: Using computers appropriately 

Most organisations have rules or guidelines covering how computers should be used. This often 
bans using the computer for personal emails and web browsing, and will prohibit using 
computers to create, look at, download, store or distribute material that is offensive (including 
pornography and hate material). 

Use of computers is also covered by the Computer Misuse Act (1990). The organisation is legally 
bound to make sure its computers are not used for illegal purposes, but the Act also covers 
your behaviour. The Act outlaws: 

� breaking into computer systems (unauthorised access or hacking) 

� deliberately damaging programs or data on a computer, or making the computer unusable. 

Knowledge top-up: Copyright 

Copyright protects people who create books, music, software and pictures. The person who 
creates a work keeps the rights to it even though they sell copies. Copyright law sets out how 
people may copy or use creations like these. Copyright applies to all computer software and 
text, pictures and music on the Internet – the person or organisation that created them owns 
the rights to these.  

Copyright and the Internet 

Text and pictures published on the Internet are protected by copyright in the same way as if 
they were printed in a book. Although the Internet makes it easy to copy and download 
pictures, text and music it is illegal to do so without the permission of the copyright holder. 
For instance, you may not copy a picture or news story from a website to use in work of your 
own, or to send on to someone else. 
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Copyright and software  

When you buy  software, you buy a right (or licence) to use it. You can’t make lots of copies 
and give them away or sell them, or even use them on more than one computer of your own. 
Software is covered by copyright law, just as other creative productions are covered.  

Some software is free, but much of it is still protected by copyright or licensing restrictions. 
There are different types of free software: 

� shareware is given away free for a trial period. If you carry on using it after the trial, you 
must pay for it 

� freeware is given away free and you never need to pay for it. You can give away copies, as 
long as you don’t change it or claim that it is your own creation 

� public domain software is given away free and can be freely copied and distributed and 
usually even changed. It is copyright-free. 

Check your knowledge 

Make sure you’ve understood and remembered the learning in this section by answering these 
quick questions. The answers are at the end of this section. 

1. Which ONE of these would be a breach of copyright law? 

� Photocopying a letter you are sending to a newspaper 

� Cutting an article from a magazine and pinning it on a notice board at work 

� Copying a photograph from a website and including it in your own web page 
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2. From which of the following does the Data Protection Act protect you? 

� Businesses keeping information about you that is untrue 

� Websites sending you email invitations to view adult material 

� The police keeping details of crimes you have been suspected of committing 

� People making copies of your work on the computer  

3. Which of these are you allowed to do with the personal details of customers? 

� Show them to someone else if you need help making a decision about whether to give a 
customer credit 

� Pass only the names and addresses to another organisation to build a mailing list 

� Delete a customer’s details without asking their permission. 

Remind yourself 

If you want to do more work on the topics in this section, use the course Introducing 
Computers.To find out more about 

� protecting sensitive data - work through the section Security, copyright and the law: Data 
protection legislation 

� copyright - work through the section Security, copyright and the law: Copyright. 
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Check your answers 

1. Downloading a photograph from a website and including it in your own web page is a 
breach of copyright law. 

2. The Data Protection Act  protects you against businesses keeping information about you 
that is untrue. 

3. You may delete a customer’s details without asking their permission. 



 

©  learndirect  55 

Keeping data safe 

To comply with data protection requirements it is necessary to keep data securely and safely. 

This means that we need to protect it against theft, corruption and accidental loss and keep it 

confidential. You need to know how to: 

� keep back-up copies of data 

� use passwords and encryption to keep data secure 

� protect your computer from viruses. 

Key terms 

If your work on keeping data safe is complete, you should be certain that you know what these 
terms mean: 

� back up, incremental back up, complete back up 

� grandfather-father-son back up system  

� hacking 

� user name, password 

� virus, anti-virus software. 

Knowledge top-up: Making back ups 

A back up is an extra copy of your work that you keep in case something happens to the 
original copy. To be useful, a back up must be recent so that you do not have to re-do much 
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work if you need to restore a file from it. You should back up all your important files 
frequently, including lists of contacts and important email messages. Work that is constantly 
changing should be backed up every day. 

A small file can be backed up onto a floppy disk. To back up a large file, a group of files or 
even your whole hard disk, you will probably use a file server with a lot of hard disk space, a 
tape drive or writable CDs. Label any disks or CDs clearly so that you can find the right back up 
if you need it. 

Incremental and complete back ups 

Backing up a whole hard disk can take a very long time, so most organisations use special back-
up software that can keep track of which files are used and only copy those that have changed 
since you last did a back up. This type of back-up is called an incremental back up. It is much 
quicker than a complete back up (one that copies all files, whether or not they have changed). 

 

To be safe, back ups should be kept in a different building, in a fireproof container.  
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Rotating back ups 

Many organisations use a system of rotating back-up tapes or disks referred to as grandfather- 
father-son back ups. 

� Each day, an incremental back up is made to a tape or disk labelled with the day of the 

week. These are reused each week. 

 
� At the end of each week, a full back up is made to tapes or disks labelled with the number 

of the week in the month. These are reused each month. 
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� At the end of each month, a full back up is made to a tape or disk labelled with the 

month. These are reused every three months. 

Knowledge top-up: Using passwords 

Each person has an account on a computer system and a unique user name (or ID) and 
password. The ID is not secret. It identifies each person who can use the network, so each ID 
must be different. The password is a secret code word that must be given to prove the identity 
of the user.  

You should choose a password that other people can’t guess, and you should change it 
frequently. A password should include both numbers and letters. Don’t use the same password 
for everything – the risks are greater if someone discovers your single password. Don’t write 
your password down and keep it near the computer.  

If you work with sensitive data, individual programs or files may have their own password that 
you need to give in order to use them. You must be careful to keep these passwords secret, 
too. Do not enter the password when someone is watching you, as they might see it.  

Knowledge top-up: Protecting your computer from viruses 

Viruses are programs that can disrupt your computer and destroy work stored on it. They are 
spread over the Internet, often through email, and through infected disks. A virus can’t be 
spread by just an email message, but may infect a file attached to an email message.   

To prevent your computer getting a virus, you should:  

� Use anti-virus software, running all the time on your computer, and make sure it is up-to-
date (download updates frequently). 
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� Run a virus check on all your hard disks when you first get the anti-virus software and at 
frequent intervals afterwards – you can schedule the computer to do this for you. 

� Use the anti-virus software to check any disks from anyone else that you put into your 
computer and anything you download from the Internet. 

� Don’t open email messages that look suspicious – perhaps from people you don’t know, 
with strange subject lines. 

� Use a virus checker to check any attachments you receive with email before opening them. 
If you get an unexpected attachment with email from an address you don’t recognise, 
don’t open it at all. 

� Check your own disks if they have been used in another computer. 

Visit the website for your anti-virus software frequently. It will have updates and information 
about viruses that you need to know about. New viruses appear all the time, so it is important 
to keep your anti-virus software and your own knowledge up to date. 

Check your knowledge 

Make sure you’ve understood and remembered the learning in this section by answering these 
quick questions. The answers are at the end of this section. 

1. Which of following would be a good password to use? 

� your car registration number 

� ‘password’ 

� ‘Columbus1492’ 

� your dog’s name 
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2. How often should you make a back-up copy of a database you use every day? 

� once a week 

� once a day 

� every half hour 

3. Which of these will help you to prevent viruses attacking your computer? 

� Check any email attachments with anti-virus software before opening them 

� Never send any attachments with email messages of your own 

� Shut down the computer properly before turning it off. 

Remind yourself 

If you want to do more work on 

� making back ups - work through Introducing Computers: Security, copyright and the law: 
Backing up your files and Using your computer: Looking after files on your PC – Backing 
up files on your PC 

� using computers appropriately – work through Introducing Computers: Computers in 
everyday life - Using computers appropriately. 
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Check your answers 

1. A good password should mix letters and numbers and should not be easy to guess; 
‘Columbus1492’ is the best of these. 

2. You should make a back up copy every day of a file you use frequently. 

3. To avoid viruses, you should use anti-virus software to check any email attachments you 
receive before you open them. 
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Health, safety and the environment 

There are important safety issues to bear in mind when you use computers. These relate to: 

� the hardware you use 

� your own behaviour 

� the environment. 

Key terms 

If your work on health, safety and the environment is complete, you should be certain that you 
know what these terms mean: 

� refresh rate, screen break 

� RSI. 

Knowledge top-up: Safety and IT equipment 

Computers are electrical equipment, so you need to be careful with them in the same way as 
you would be with other electrical equipment. In addition, how you arrange your equipment 
and the types of equipment you use can affect your safety.  

� Sit 60 cm (24 inches) from your monitor and at least the same distance from anyone else’s 
monitor. 
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� Use a screen with a high refresh rate to avoid flicker which could cause eyestrain. 

� Keep the screen brightness turned down to protect your eyes. 

� Work in good light that is not too bright and doesn’t reflect off the screen. 

� Don’t sit facing the window or turn the screen contrast up too high -  the high contrast 
between the screen and the rest of your field of vision can cause eyestrain. 

� Don’t sit with a window behind you – the best place is beside a window so that light does 
not reflect off the screen. 

� If there is glare from your monitor, use a monitor filter. 

� Use a well-adjusted, stable chair that supports your back. A proper computer operator’s 
chair will help you to avoid back and shoulder pain.  

� Make sure printers have good ventilation, and don’t sit very close to a printer. This is 
particularly important for laser printers, which produce ozone gas while working.  
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Knowledge top-up: Safe behaviour 

Some health problems may be caused by careless use of computers and bad posture when using 
them. Follow these guidelines to keep yourself safe. 

� Sit with your eyes level with the top of the monitor. 

� Sit with your feet flat on the floor to reduce strain on your back. 

� Take frequent screen breaks - move your eyes away from the screen every few minutes to 
give them a rest, and get up to walk around occasionally. 

� Avoid too much noise by shielding or moving away noisy equipment such as printers. 

Knowledge top-up: Avoiding RSI 

RSI is repetitive strain injury – a painful condition that can result from making the same small 
movements repeatedly. It sometimes affects people who use a mouse a lot when they work at 
the computer.  

To avoid RSI, make sure your arms and wrists are well supported while you work. A wrist pad 
can help. Make sure your desk and chair are at a suitable height so that your arms slope 
downwards gently and don’t rest on hard corners. 

Vary the activities you do, if you can, and take regular breaks from using the computer to let 
your arms rest. 
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Knowledge top-up: Helping the environment 

It is not only you but the environment that can be damaged by thoughtless computer use. To 
minimise the impact on the environment you should reduce waste and recycle as much as 
possible. 

� refill and recycle toner cartridges from printers 

� re-ink and re-use ribbons from older printers 

� dispose of old printer cartridges and computer equipment properly – don’t put it in with 
normal waste 

� try to buy computers with recyclable parts and sold in recyclable, biodegradable packaging 

� recycle paper from all printers 

� turn the monitor off if you are not using the computer, but need to leave the computer on 
(eg for back-up procedures or for it to complete a task) 

� buy computers with energy-saving options and use those options – such as running on 
standby when not in use, or switching the screen off rather than starting a screensaver 

� use tutorials and manuals on screen rather than buying paper copies. 

Environment-friendly equipment uses less power – so it also saves money. 

Think about whether you need to print each document before doing so. Some documents can 
be used in electronic form, including: 

� working drafts of documents 

� documents that change frequently or are often updated 
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� email messages. 

You will always need to print some documents, but keep printing to a minimum. To avoid 
printing lots of drafts of a document, get used to checking work on screen and using Print 
Preview to check how a document will look when it is printed before you actually print it. You 
may spot errors you can correct, saving a wasted print run. 

Check your knowledge 

Make sure you’ve understood and remembered the learning in this section by answering these 
quick questions. The answers are at the end of this section. 

1. Which of these will help you to avoid RSI? 

� Sitting at least two metres from the printer 

� Taking regular breaks from working at the computer  

� Sitting so that your eyes are no more than 30 cm from the monitor 

� Using a chair that supports your back. 

2. Which of these will help you to avoid eye strain? 

� Sitting with the window behind you so that natural light falls on the computer screen 

� Sitting with the window in front of you to avoid reflections on the screen 

� Sitting with your eyes 20-30 cm from the monitor  

� Sitting with your eyes at least 60 cm from the monitor 
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3. Which of these statements about laser printers is TRUE? 

� They produce ozone gas 

� The cartridges cannot be recycled 

� They are much cheaper to buy than inkjet printers 

� It is dangerous to try to refill the cartridges 

4. Which ONE of these practices would be a good way of reducing waste in an office? 

� Using an inkjet printer instead of a laser printer 

� Turning down the brilliance on computer screens 

� Checking draft documents on screen instead of printing them 

� Using floppy disks instead of rewritable CDs. 

Remind yourself 

If you want to do more work on health and safety and protecting the environment - work 
through the section Computers in everyday life: Health, safety and the environment in 
Introducing Computers.
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Check your answers 

1. To help avoid RSI, you should take regular breaks from working at the computer. 

2. To help you avoid eye strain, you should sit with your eyes at least 60 cm from the 
monitor. 

3. Laser printers produce ozone gas while they are working.  

4. To reduce waste you should check draft documents on screen instead of printing them. 
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All finished! 

Once you have read through the Revision guide and revisited any areas of the course you want 

to work through again, you are ready to take your assessment.  

Good luck!
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Glossary 

 

anti-virus software software to protect a computer from being infected with computer 

viruses 

application computer software for carrying out a particular type of task, such 

as working with text or managing financial accounts 

attachment file sent with an email message 

autonumber sequential numbers added automatically to entries in a database 

or spreadsheet 

back up extra copy of data or programs kept for security 

bar chart chart showing a set of bars that are sized in proportion to the 

quantities they represent 

browse look through a disk, folder or the world wide web to locate a file 

cell space in the grid of  spreadsheet to hold a value or formula 

clipboard allocated area of computer memory used to store copied or cut 

data temporarily 

copyright protection of the rights of the creator of artistic or original works, 

including software 



Glossary 
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CSV file file format for transferring values from a spreadsheet between 

applications 

currency format number format for spreadsheet data that shows pounds and pence 

data point single plotted point on a graph or chart, corresponding to a single 

item of data 

data protection regulations controlling the use and storage of data about 

individuals 

database software application for storing, managing and processing large 

amounts of data 

decimal number format that has a decimal point and numbers after it 

desktop publishing using software to produce complex arrangements of styled text 

and images 

digital camera camera that stores pictures on a computer chip rather than on a 

film 

disinfect remove viruses from a disk or file 

download copy information from the Internet to your computer 

edit make changes to 

email electronic message sent between computers connected to the 

Internet 
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embedded data integrated into another file with no link to its source 

encryption turning a file or message into code so that it cannot be read 

without a special ‘key’ (code) to decode it 

executable file program 

field single item of information, or slot allocated to hold a single item 

of information, in a database 

file extension three letters at the end of a file name which shows the file type 

file server computer which provides services – such as printing, running 

software, or disk storage space – to other computers connected to 

it over a network 

firewall software or hardware barrier to restrict the traffic of information 

between a computer system and the Internet 

footer information printed at the bottom of every page of a document 

form fill-in form displayed on screen to put information into a database 

formula instructions for carrying out a calculation in a spreadsheet cell 

freeware software that can be used and distributed without payment 

grandfather-father-son system of backing up data that stores copies of data each day, 

each week and each month, overwriting older copies in a cycle 
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graphical user interface way of working with the computer that uses windows, icons, 

menus, and a mouse  

hacking breaking into computer systems without authority 

header text repeated at the top of every page 

icon small picture used to represent something on the computer 

image editor software application for creating and modifying pictures  

import insert into another file 

incremental back up back up only the files that have changed since the last back up  

integer whole number 

Internet worldwide network of linked computers 

licence permission to use software as long as specified conditions are met 

line chart chart made by plotting points and drawing a line through them, or 

a ‘best fit’ line between them 

model copy in computer software a real-life situation or activity 

monitor filter flat panel that covers a monitor to reduce screen glare 

multimedia file that combines text, pictures, sound and sometimes moving 

images 

network collection of computers linked together by cabling or radio waves 

so that they can share data and resources 
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OHP overhead projector 

password secret word used to confirm a user’s identity 

pie chart chart that shows proportions of a total by representing them as 

segments of a circle 

presentation series of slides combining text, images, sound and sometimes 

movies shown on the computer 

public domain software software which can be freely used, copied, adapted and 

redistributed 

query specification of a search, sort or other operation to investigate 

data held in a database  

record collection of information about an object, person or other entity in 

a database 

refresh rate frequency with which the image on a screen is redrawn 

replicate copy the content and format of cells in a spreadsheet to another 

set of cells 

report display of results of a search, sort or other query in a database 

RSI repetitive strain injury – damage caused to the body through 

repeating the same small movements, such as those involved in 

using a mouse 



Glossary 

©  learndirect  75 

RTF file file format for transferring styled text between word processor 

applications 

scan make an electronic copy of a picture or document to use on a 

computer 

scatter chart chart with data points plotted but not joined by a line 

screen break time spent away from, or looking away from, the computer screen 

screensaver moving image that can be set to appear on the screen when you 

are not using the computer  

search page web page used to search the world wide web for other web pages  

shareware software that can be tried for free, but must be paid for if you 

continue to use it after the trial period 

slideshow series of slides shown on the computer screen, combining text, 

images, sound and sometimes video 

spreadsheet software application for carrying out calculations and modelling on 

numeric data 

string sequence of characters 

style collection of text attributes, such as size, colour and font 

table collection of related information in a database 
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text editor software application for handling plain text with no styling or 

formatting information 

toner powdered ink used in printers 

user name name used to identify a computer user to access a personal 

account on the computer, the network or a website 

virus malicious computer program that can cause damage 

web page single page of text and images viewed on the world wide web or 

other network 

website collection of web pages 

wildcard character used to stand for one or more variable characters in a 

search 

word processor software application for entering, styling, editing and managing 

text 

world wide web vast collection of web pages kept on computers around the world 

that can be viewed using the Internet 

write-protect protect a computer disk so that its contents cannot be changed 

zipped compressed to occupy less disk space.
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